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Introduction

SureSync is a powerful file replication & synchronization utility which can be used to ensure users
on your network are always working off of the most recent version of critical files, for disaster
recovery purposes, for software distribution, and much more.

This evaluator’s guide is designed to walk you through the initial setup of the SureSync product
with the SPIAgent File Locking Add-On. By reviewing this guide, you will become familiar with
how to utilize SureSync, SPIAgent, and SPIAgent File Locking to implement an efficient and
powerful synchronization / replication infrastructure in your network

System Requirements

SureSync’s basic operating system and hardware requirements are:

e Supported Operating Systems: Windows Server 2008 R2; Windows Server 2008;
Windows Server 2003; Windows Server 2003 R2; Windows Vista; Windows XP;
Windows 7

e Processor: 400Mhz Pentium Processor or equivalent (Minimum); 1Ghz Pentium
Processor or equivalent (Recommended)

¢ RAM (total for system): 256MB (Minimum); 1GB (Recommended)

o Hard Disk: 30MB for application files; 20MB+ for database

e Display: 800x600, 256 colors (Minimum); 1024x768 high color, 32-bit (Recommended)

SureSync can synchronize data to machines running operating systems such as Windows 95,
Windows 98, Windows NT 4.0, Windows 2000 and non-Windows machines such as Macintosh
and Linux machines via UNC path but the software itself must be installed on one of the
supported operating systems listed above.

SureSync requires a database which is used to store configuration information. The following
formats are supported:

e Microsoft Access (default)
e MSDE 2000 / SQL Express 2005 / SQL Express 2008
e SQL Server 2000/ SQL Server 2005 / SQL Server 2008

To achieve optimal performance, a SQL database is strongly recommended for setups using
multi-directional Rule types, environments with more than 50 Relations defined, or environments
where hundreds of thousands of files will be processed.

SureSync requires a number of Microsoft components to be installed on the system. The
SureSync installer will detect the versions your system is running and offer to upgrade them as
needed.

Microsoft .NET Framework 3.5 with Service Pack 1
Microsoft MDAC 2.8 Refresh with Service Pack 1
Microsoft Visual C++ Runtime 9.0 with Service Pack 1
Microsoft Windows Installer 3.1

Microsoft XML Parser 6.0

Microsoft Jet 4.0 with Service Pack 8
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Contact Information

If you need further information about SureSync or need clarification on anything within this guide,
please contact our support group and they will be happy to assist you with your evaluation.

Software Pursuits, Inc.
1900 South Norfolk Street, Suite 330
San Mateo, CA 94403

Phone: +1-650-372-0900
Fax: +1-650-372-2912

Sales e-mail: sales@softwarepursuits.com
Support e-mail: support@softwarepursuits.com

Technical support is available between 8:00AM and 5:00PM PST Monday through Friday.

Required Add-Ons for SPIAgent File Locking

In order to use SPIAgent File Locking, you will need to license the base SureSync product, the
SPIAgent Add-On and the SPIAgent File Locking Add-On for each machine involved in the
synchronization. This section outlines the functionality provided by the required Add-On licenses.

SPIAgent Add-On

The SPIAgent is a powerful Add-On license for SureSync, which contains a number of
performance enhancing features. This license is required to perform File Locking.

e Real-Time Monitors
Real-time replication increases data availability by continuously monitoring data for
updates. By copying files immediately after they change, SureSync can avoid folder
scans that are necessary for scheduled jobs.
e Adaptive Delta Technology
SureSync copies only the changes made to a file, reducing synchronization time and
decreasing the consumption of network resources.
0 Delta Processing to Non-Windows Machines
If you map a non-Windows drive to a drive letter on a Windows machine you can
process delta copies to that non-Windows machine. This in turn provides
bandwidth savings between any machines, regardless of the OS.
e File Compression
Transmit files in a smaller package across your network by compressing them. File
compression is particularly useful on slow network connections. SureSync also allows
you to specify the level of compression to control the impact on your system.
e TCP/IP Transmissions
Transmissions across the Internet give you more options on how you connect to remote
machines. Now it is even easier to keep office branches connected to the information
they need.
e Encryption
Ensure your files are being transmitted securely by utilizing the option to encrypt each file
transmission. This is an especially useful and necessary tool when transmitting sensitive
data across the Internet.
e Change Journal Support for Schedules
When a Schedule is configured to run a Relation using the SPIAgent Add-On, SureSync
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utilizes the NTFS Change Journal, which minimizes the amount of scanning a
synchronization job must perform. Eliminating much of the scanning creates a significant
performance improvement for Schedules.

SPIAgent File Locking Add-On

The SPIAgent File Locking Add-On requires the SPIAgent to be licensed and in turn gives you an
additional benefit in file sharing environments. The SPIAgent File Locking Add-On eliminates the
possibility that a file could be changed on multiple sides of a synchronization resulting in a more
efficient synchronization with zero risk of lost changes. A user who attempts to open a file that is
already in use will receive an indication from the application that the file is locked.

Other SureSync Add-Ons

Software Pursuits also offers additional Add-On products for SureSync which provide additional
functionality. The available Add-On products include:

ArchiveSync Add-On

SureSync’s ArchiveSync Add-On allows users to create versioned backup copies of files,
providing an efficient disk-to-disk backup solution. Versioned file copies allow users to quickly
restore files to a specified point-in-time, without sifting through tape backups. Additionally, when
archiving or restoring, the ArchiveSync Add-On will allow you to backup and restore security
privileges as well.

Archiving can be done in real-time to continuously protect data, effectively eliminating tight
backup windows during the evening. ArchiveSync will also automatically thin out your archive to
clean storage up.

Please consult the SureSync with ArchiveSync Add-On Evaluator’s Guide for further details.

What is SPIAgent File Locking?

The SPIAgent File Locking Add-On is a powerful enhancement to SureSync that makes it simple
to collaboratively share files between multiple offices while ensuring that users cannot make
changes to the same files at the same time.

The SPIAgent File Locking Add-On will lock a file on all paths when a user opens the file on one
machine. In this example, we have three servers named “ServerA,” “ServerB,” and “Server C.”
These machines all contain a copy of a file share that is being synchronized by SureSync with a
Real-Time Monitor.
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L

ServerA ServerB

While the file is locked with the SPIAgent File Locking Add-On, no other user can access a write-
enabled copy of the file. For example, if a user attempted to open the “Documentl.doc” file on
“ServerB,” they will open a read-only copy.

Once the user completes their changes to the “Documentl.doc” file on “ServerA,” saves those

changes and closes the file. SureSync will immediately replicate the changed version of the file to
“ServerB” and “ServerC.”

L
ServerA Q ServerB
8

ServerC

As soon as the file has been synchronized to the other machines, the lock on the file will be
released by SureSync. Users can then access the updated file with write access from any of the

machines.

ServerA ServerB

ServerC

If a user opens the file again on one of the paths, then the locking process will repeat itself,
ensuring that only one user has write access to the file at any given time.
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Supported Applications

Generally speaking, applications use handles to open files. Applications can open a file, establish
the open file handle and that lets the operating system and other applications know that the file is
currently open. Applications that work this way are supported by the SPIAgent File Locking Add-
On. An application can also open a file, read the file into memory, and then release the open file
handle on the file. With applications that open files in this way, the SPIAgent File Locking Add-On
is unable to determine that the file is open and no lock will be established.

The application opening the file determines if locking will function, not the file type. For example, if
you open a .txt file in Notepad, that .txt file will not be locked. This is due to the fact that Notepad
does not establish and maintain the required handle in the file system when it opens the file. On
the other hand, if you open that same .txt file in Microsoft Word a lock will be established because
Word properly established and maintains the open handle in the file system.

This list contains applications that Software Pursuits has tested the SPIAgent File Locking Add-
On with and have determined that locking will occur. This list is not comprehensive as there are
far too many applications available on the market to provide a complete list. We will continue to
update this list as we test additional applications and as we receive feedback from customers. If
an application that supports multiple file types appears on this list, all compatible file types should
be lockable.

Supported Applications

Autodesk AutoCAD
Microsoft Word
Microsoft Excel
Microsoft PowerPoint
Microsoft Publisher
Microsoft Visio
Microsoft Access
Adobe InDesign
Adobe PageMaker
QuarkXPress
OpenOffice.org Writer
OpenOffice.org Calc
OpenOffice.org Draw
OpenOffice.org Impress
OpenOffice.org Math
OpenOffice.org Base

Unsupported Applications

Adobe lllustrator

Adobe Photoshop

Adobe Acrobat
Macromedia Dreamweaver
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Expected Application Behavior when Encountering Locks

The SPIAgent File Locking Add-On establishes locks on files at the file system level. It does not
provide any form of messaging to the user when they encounter a locked file. The behavior that
the end user will encounter depends on the applications in use in the environment. When
deploying SureSync with the SPIAgent File Locking Add-On, it is essential that you inform the
end users about what they can expect to experience when encountering locks. This section will
highlight the behavior of some widely used applications while SPIAgent File Locking is active.

Note: It is important to understand that the behavior you see can be different depending on where
the file is locked from with Office applications. If a user opens the file on the same path as the
lock, you should see prompts like the one below. This occurs because the Office application's file
in use handler grabs the open request and processes it. If the file lock is opened from a remote
machine, you should see Read-Only in the title bar of the file. The SyncLockStatus Add-on can
provide additional messaging to the end users if additional clarity is needed.

Word 2003

When opening a file that is locked in Word 2003, the user will be prompted with the following “File
In Use” dialog box. Generally, the user will select “Open a Read Only copy.”

File In Use X

BootBack Evaluator's Guide.doc is locked for editing by "Marya
Riddle',

() Receive notification when the original copy is available

[ Ok, l’ Cancel ]

Word will then open a read-only copy of the file as signified by the “[Read-Only]” in the title bar.

2} BootBack Evaluator's Guide.doc (Read-Only) - Microsaft Word

DEe Edt yew juet Fgmar Jods Tbe Mindw heb AddePOF  Acobat Comments 3
AT RESETRE IENk A o) &t B0 D -] diged 74 e 4, - e -u - [Ble u EEE A F
el Shomeg i = Show= 51 93 2= bd =1 4 % - L] @ i

FI RN e |

Depending on the operating system of the file server, the first “File in
Use” screen might not appear. The user may get the Read-Only copy
automatically and only see the second screenshot.

Word 2007

When opening a file that is locked in Word 2007, the user will be prompted with the following “File
In Use” dialog box. Generally, the user will select “Open a Read Only copy.”
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File In Use (P ]

BootBack Evaluator's Guide.doc is locked for editing by 'Marya
Riddle'.

Do you want to:
©

() Create a local copy and merge your changes later
() Receive notification when the original copy is available

o) (o ]

Word will then open a read-only copy of the file as represented by the “[Read-Only]” in the title

Home | Imsert Page Layout References Mailings Review  View At Arrbat ("

Rl e — - 2 Fina »

ALK SR sambccr AaBbCc ASBBCC AaBbCel AaBhCE |

Bl U oo % A% ! =AM L Haimal L Seclect

Clipbasa C Font Faragraph Styles Editing

Depending on the operating system of the file server, the first “File in
Use” screen might not appear. The user may get the Read-Only copy
automatically and only see the second screenshot.

Excel 2003

When a user opens a file in Excel 2003 that is locked, the program will automatically open a read-
only copy. This is signified by the “[Read-Only]” in the title bar.

B Microsoft Exeel - COM+ Customers.xls [Read. Only]

fS) g gt Wew Juet Fgmst Joos Qabs Wndow bel  Adoheroe

RN BEVE T RN N A0 e S JR e e e 1 TUN R Y |
™ - - B 7 U EEME S % o AR EE -0-A-0
5 B B B O I ool Wy gy T B

Excel 2007

Excel 2007 will display the following dialog box when opening a file that has been locked.
Generally, end users will select “Read-Only,” but they can also choose to be notified when the file
becomes available for write access.

File in Use [ =
COM+ Customers. xls is locked for editing

by ‘Marya Riddle'.

Open 'Read-Only' or dick 'Motify' to open read-only and receive notification
when the document is no longer in use. 2l

Clicking “Read Only” will result in the file being opened and “[Read-Only]” will be displayed in the
title bar.

—_— - S— -

gy 5 R e — ——
iC3) — - e
= | Home tiwrt Page Lot Fremutag Dt Broew  iew iscteint Acrotu - - =
=, ks armt AT - = 2 a ! [ 1 T Tx g I autatem = A
\ " - Swean e Gamanst [ Homat Had = b, 2
o i : :ﬂ o it e ::-’ r{l‘a
it . e ke Cirder + | B | Contiiomst Pormst | Boet £t Gelate Farmsi '8 P
0. o Py | 1 A bl | S | g cinter B mi || T - 0T 2| pie e 2 = ieinct+

Chubaicd g Pant g Abgnard = Humgar : e, iy

Depending on the operating system of the file server, the first “File in
Use” screen might not appear. The user may get the Read-Only copy
automatically and only see the second screenshot.
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PowerPoint 2003

When a user opens a file in PowerPoint 2003 that is locked, the program will automatically open a
read-only copy. This is signified by the “[Read-Only]” in the title bar.

BT Microsoft PowerPoint [Hew Features in SureSync 5. pgt [Read-Only]]

] Be EAt Wow et Fgmat Tk SkeSow Wndow Heb  AdobeFOF - %
VT BEYIE RV O R A | W) TN T = - B s U s [E]EE =S A W GE A oo tien e [
imaliall
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PowerPoint 2007

When a user opens a presentation that is locked with PowerPoint 2007, they will be prompted
with the dialog below, and can choose to open a read-only copy or cancel the opening.

Microsoft Office PowerPoint &J

‘ '0' Vnettest\FileLockingTest\Mew Features in SureSync 5.ppt is being modified by Marya Riddle. Do you want to open a read-only copy?

| Open | I Cancel J

If the “Open” button is selected, then PowerPoint will open the file with “[Read-Only]” in the title
bar.

(ol d ¥ Hew Festures in SureSyne 5.ppt [Read-Ondy] | Computitabiy Moe] - Microsohi PownrPont 174 -

Intet Deiign  Amimstiom:  isde Show LI view Aggdnt  Acobat w

¥ e il (B

Depending on the operating system of the file server, the first “File in
Use” screen might not appear. The user may get the Read-Only copy
automatically and only see the second screenshot.

Other Notes

While the SPIAgent File Locking Add-on is running, users may sometimes attempt to save a
version of a document over the network version which is locked. This can occur if they save a
copy of the file locally, make changes, and then attempt to save them back. This will generate an
error because the file is locked and Windows will not allow their version to be saved over the
locked version. This is expected behavior but can cause some confusion.

For example, the user might see something like:

Micrascft Office Word Lth

This file is read-only.
l \ (BootBack Evaluator's Guide.doc)

Show Help ==

We strongly recommend informing users that this situation can happen. The user should attempt
to save the changes again later, as those changes will be allowed when the file has been
unlocked.

Our Scenario

This guide will walk you through the configuration of SureSync using the SPIAgent and SPIAgent
File Locking Add-Ons to accomplish a multi-directional synchronization between three servers.
The three machines in questions are named 9PGGCG1-JeffK, NETTEST, and
WINDOWS2008TEST. The folder being synchronized will be C:\SalesData on each machine.
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With this common scenario, users on any of the machines will be able to make changes to the
monitored directories and those changes will be reflected on the other servers. This includes
additions, deletions, and modifications. This scenario is further enhanced with file locking.

File locking is only available with Real-Time Monitors using multi-
directional Rules. File Locking cannot be performed with a Schedule.
SPIAgent and SPIAgent File Locking licenses are needed for each
machine involved.

9PGGCG1-JeffK

7N\
S > £

NETTEST WINDOWS2008TEST

Installation

To begin your SureSync trial, you must install the correct SureSync components on the right

machines. SureSync is installed using a Windows Installer (MSI) driven installation application.

SureSync and all Add-On products are installed using the same installer.

For this scenario, the full SureSync application will be installed on one machine (9PGGCG1-
JeffK) and the SPIAgent will be installed on the other two machines (NETTEST and
WINDOWS2008TEST) as illustrated below. The file locking components will be installed on all
machines.

9PGGCG1-JeffK

8

..... < : ’\/ e @
@ s A 21 SPlAgent
= o ‘ g =% ’

NETTEST WINDOWS2008TEST

On the 9PGGCG1-JeffK machine, we will run SureSyncSetup.exe and select SureSync with
SPIAgent File Locking as the installation type in the installer. This will install the complete
SureSync application plus the SPIAgent File Locking driver and designate 9PGGCG1-JeffK as
the machine where we configure and run our synchronization job.

Software Pursuits, Inc.
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SureSync - InstallAware Wizard E

"

Select an installation type:

SureSync
Installs the full SureSync application used to configure
and run spnchronization and replication jobs.

| @ SureSync with SPIAgent File Locking!
Inztalls the full SureSync application and the components
required for the SPlAgent File Locking Add-on.

SPlAgent
Inztalls the SPlAgent service anly.
I SPILAgent with SPIAgent File Locking Product install path:
I Installs the SPlAgent service and the components C:\Program FileshSoftware PursuitshSureSync Browse...

required for the SPlAgent File Locking Add-on.

| < Previous |[ Mext > l| Cancel |

On the NETTEST and WINDOWS2008TEST machines, the SPIAgent with SPIAgent File Locking
installation should be performed. This is accomplished by launching SureSyncSetup.exe on those
machines and selecting “SPIAgent with SPIAgent File Locking” as the installation type. This setup
type installs both the required SPIAgent components and the SPIAgent File Locking Add-On
driver.

Launch SureSync for the First Time

Now that all of the required components have been installed on the machines which will be
involved in the synchronization, we can continue with the configuration. To launch SureSync for
the first time, go to the Start menu, select the SureSync folder and click on the SureSync icon.
This will launch the SureSync desktop application where you will perform all of your
synchronization job configuration. On the first launch of the application, SureSync will create an
Access database to store your configuration information.

The default database format for SureSync is Microsoft Access.
SureSync also supports Microsoft SQL and this database format is
recommended for environments running many multi-way Rules or a
large number of jobs to achieve optimal performance. Please refer to the
Upgrading from an Access to SQL Database knowledge base topic for
more information.

Once the database has been created and the SureSync desktop has loaded, you can proceed
forward with your configuration.
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Installing the SureSync Scheduler

The SureSync Scheduler is a Windows service that runs on the main SureSync machine. This
service is responsible for launching Schedules at the correct times and for running Real-Time
Monitors. You must have a Scheduler running in order for your Real-Time Monitor to start.

To install the SureSync Scheduler service, go to the Tools menu within SureSync and select
“Schedulers...,” which will launch a window like the one below.

4 Scheduler Servers » h— ﬁ

Scheduler Service on this machine

Install Uninstall

Identify the servers to run the Scheduler Service. You may start or stop the
Scheduler Service from this form.

| (-] Add
B

To install the Scheduler, click the “Install” button, which will launch a window like the one below.

= ———— |
ﬁ Scheduler Service Logon Information ﬁ

Userld [«domain="<user id:]

domain'user

Cancel

Confim Password

_——

You are about to install the Scheduler Service on your cument
machine. Please specify the user name to use for this service in
the format

<domain name>"<user name:

or <computer names'\<user name. You may specify \<user
name:for an account on the local machine.

The account you specify must be a member of the Administrators
group for your machine.

Enter the username formatted as machinename\username or domainname\username. This
account must be an administrator on the machine. Click “OK” to install the service.

Software Pursuits, Inc.
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Scheduler Service on this machine

Install Uninstall

Identify the servers to run the Scheduler Service. You may start or stop the
Scheduler Service from this form.

,ﬁ';‘ 3PGGCG1-JEFFK (Running) Remove

Once the service has been installed, click on the machine name and click “Start.” The Scheduler
will now be listed as Machine Name (Running).

Configuring the SPIAgent Machines

The next step in the configuration is to define the remote SPIAgent machines in SureSync. To do
this, launch SureSync, click on the “Tools” menu, and then select “SPIAgent Setup.”

-

SPIAgent Settings and Computer References =HACE X

Select a computer from the list to edit its settings. _z‘

SPlAgent Configuration
[] Run the SPIAgent Service on this computer
{Defautt) O=Use default
Deploy Updates...
Trace K
Trace D ‘wrap Traces

This machine has not yet been evaluated for the license needed.

Test Bemove Save

A

Select the SPIAgent from the drop down menu to begin configuring it. If the agent you want to
configure does not appear in the list, you may enter a name for it by selecting "Add New
Machine" from the drop down menu.

The machine name listed in the "Select a computer from this list to edit
its settings" drop down menu must be the actual machine name for the
machine you're trying to connect to. Using an IP address or a random
name in the drop down menu will result in the test failing.

Software Pursuits, Inc. 14
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You will then want to:

1. Check the box that says "Run the SPIAgent Service on this computer."”

2. Enter the IP address or DNS name for the machine running this SPIAgent into the "Agent
IP or DNS Name" field.

3. Enter a username with adequate permissions to that machine in the “Default User ID”
field. We recommend a domain administrator account. Be sure to configure the account
as domain\user. If you wish to use a local account on that computer, it can be formatted
as machinenamel\user.

4. Enter the password for the account in the "Default Password" field.

5. Make sure the user account specified here has "log on as batch job" rights on the
machine in question.

6. Click save and then test to verify the configuration.

The “log on as batch job” right can be assigned by going to the Start
Menu, selecting Administrative Tools, and then Local Security Policy.
under User Rights Assignment you will find the “log on as batch job”
right. On domain controllers, you must use the Domain Controller
Security Policy applet because they do not have Local Security Policy
available.

These steps should be done for each remote SPIAgent that will be used. In the example
scenario, NETTEST and WINDOWS2008TEST would be defined. An example of a completed
SPIAgent configuration is shown in the screenshot below.

r v
m SPIAgent Settings and Computer References |£|£Iéj
Select a computer from the list to edit its settings. | nettest lz‘
Server (Server 2003 or later) Version 5.2
SPlAgent Corfiguration
W| Run the SPlAgent Service an this computer
Agert IP or DNS Name  |nettest
Agent’s TCP Listen Port  |{Default) | O=lse default
Default User ID (Domain“\User) |[domain‘user
Default Password
Deploy Updates...
Check trace options below only if instructed by Technical Support
Trace C Trace K
Trace S Trace D ‘\wrap Traces
This machine requires a standard server and an agent license. A SPlAgent license is required. i
The User ID entered must have log on as a batch job’ rights for this server.
Test Remove Cancel | [ Save

Creating the Relation

Relations are the basic building blocks of the SureSync application. Each Relation contains the
root paths (source and destination paths) that apply to that Relation and options for the Relation.
Each Relation also contains one or more Rules which tell SureSync how to replicate &
synchronize data. The Relation and the Rule are created together in one wizard.
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The wizards are designed to quickly and easily configure the basic
options needed to get a Relation up and running. SureSync is an
extremely flexible product with many advanced options. Additional
options can be specified on the properties panels for the Relation after it
has been created.

To create your Relation, launch SureSync and then go to the "File" menu, select "New" and then
select"Relation."”

Name Your Relation

ﬁ Relation Wizard (=] E i

Relation Name

Relations are used to build jobs, such as Schedules and Monitors. A
Relation defines the relationship between folders that are to be
synchronized or replicated. Each Relation must have a unique name.
This wizard will set basic properties. You can set advanced options later
using properties displayed on the main form.

What do you want to call this Relation?
Sales Data

Describe this Relation (optional)

A

The first panel in the wizard allows you to name your Relation. Enter the name of the Relation
and an optional description and click “Next” to continue. The Relation name used for this example
will be “Sales Data.”

Specifying Root Paths

The next panel is used to specify the source and destination root paths that you want to
synchronize. Later in the wizard you will specify which path is source and which is destination. In
this dialog box you are simply listing the source and destination paths, which will be part of this
synchronization.

There must be at least two root paths specified (a source and a
destination) to have all Rule types available. Later on in the wizard you
will get to specify which path is the source and which is the destination.
If you specify only one path then the only Rule methods available later in
the wizard will be “Delete” and “Skip.”

Root paths are added by clicking the “Add” button at the bottom of the panel to display the “Select
a new root path” panel shown below.

For this example, our root paths are:
e C:\SalesData on 9PGGCG1-JeffKk
e C:\SalesData on NETTEST
e C:\SalesData on WINDOWS2008TEST
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First, we will select the local path on 9PGGCG1-JeffK by browsing to that path through “My
Computer,” highlighting the directory and clicking “OK.”

ﬁ Select a New Root Path E@g

/" Path | Optio Plage
Path will be accessed via this SPlAgent
(Local Agent/Mo Agent) lz‘
. NVIDIA -
| OpenFilesDest
, Output
, PerfLogs
, Program Files
, ProgramData —
J pvkimprt |E|
' SalesData i
| Setup
| SourceSafe
£l sPiZipzip
., SQL Restores
, SureSync 6 Performance Tests
, SureSync Performance Testing
. SureSync Test Folders -
Root Folder b
C:\SalesData
[ caneel |[ ok |

Once that path has been added, we must add the paths for the remote machines. Click the “Add”
button again to add a new path. Then you will select the machine name from the “Path will be
accessed via this SPIAgent” drop-down menu, browse to the path, and then click “OK.”

When selecting a remote SPIAgent from the drop-down, the browse
panel will display the drives and folders from that remote machine as if
you were sitting down in front of the computer.

~

ﬂ Select a New Root Path SRNC

# Path | Options-| SPlAgent

Path will be accessed via this SPIAgent

NETTEST [+]
1 Program Files -
| QAFiles

__| ResumeTestDestination
| Sales Sample Data

] sl Dsc

| spoolerlogs

1l SureSync Performance Testing
1 SureSync Test Folders
| SureSync Trace Logs
] TEMP

] Test

__| TestFiles

1 TestShare

| TestSharel

m

I ] traces -
Root Folder
C:\SalesData
Cancel | [ ok |
Software Pursuits, Inc. 17

www.SoftwarePursuits.com




Click “OK” to add the path. Continue clicking “New” and adding paths until all the paths involved
in the synchronization are present.

ﬁ Relation Wizard =HAEN X |
Root Paths
Specify the source and destination root folders for this Relation. The
direction of your copying is determined by your Rules, which will be
created shorthy.
Agent Name Path Relative to Agent
[Local Agent] {New} C:\SalesData
METTEST {New} C\SalesData
WINDOWS2008TEST {New} C\SalesData
4 T 3
Lohdd Y | Edit. | [ Remove |
[ Cancel l [ < Back “ Mext = l

A i

Once all of the paths have been entered, press the “Next” button to continue.

Determining the Best Rule

SureSync offers a number of different replication & synchronization methods, allowing a great
deal of flexibility in how your data is handled. A chart detailing each of these Rules can be found
in the help file under “Rule Methods Summary.”

Selecting Your Rule

On this next panel we will specify the Rule to use for this job.

If the panel indicates that only the "Delete" and "Skip" Rules are
available, you have selected only one root path. You should use the
"Back" button to return to the root path entry panel and add your other
root path(s).

The type of Rule we will be using in this example is "Multi-Mirror." Click on the Rule you wish to
use.
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E Rule Wizard for Sales Data l =

Rule Type

What synchronization method do you want to use?

Compare

Delete

Differing Master Copy
Exchanging Copies
Forced Master Copy
Mimor

Move

Recent Master Copy
Skip

Replaces, adds, and deletes files and folders in multiple directions making each path
iderttical to all the others. The latest modification date determines the source file to copy.

[ Resclve updates in multiple locations by copying the latest version

e

Click the "Next" button to continue.

Selecting Source and Destination

The next panel is where you indicate which root path is to be used as a source and which is to be
used as a destination. This panel will look different for one-way and multi-way synchronization
Rules. With a one-way Rule, there will be a source and destination section of the panel. With a
multi-way Rule like the Multi-Mirror we are using in this example, SureSync will just list the paths
to be included in the synchronization job. This is because all paths in a Multi-Mirror are both a
source and a destination, depending on where the changes occur.

Your wizard panel should look like the one below:

ﬁ Rule Wizard for Sales Data =SHAE X

Root Paths

Specify each root path which should be synchronized to create identical
copies. Subfolders and file masks can be specified elsewhere. You
cannot filter rules by root path but f a rule applies. it only affects the
selected roct paths.

Agent Name Destination Root Path
(Al Root Paths)

[ 8PGGCG1-JEFFK ChSalesData

] METTEST ChSalesData

] WINDOWS2008TEST Ch\SalesData

4 1 2

| | Camcel || <Back | MNext>

Filtering Subfolders

The next panel in the wizard allows you to include or exclude specific subfolders. The default “\"
| means to include all subfolders. You can enter subfolders into the text field, or select them using
the checkboxes in the browse dialog on the lower portion of the wizard panel. Folders are
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excluded by placing a minus character (-) in front of the folder name. Multiple folder entries are
separated by the vertical bar character ().

ﬁ Rule Wizard for Sales Data =RECIHL X

Subfolders

Select one or more subfolders from any noot path. Separate subfolders
with vertical bar characters (). Subfolder values nomally start and end
with & backslash.

[SPGGCG1-JEFFK] C\SalesData
[METTEST] C:\SalesData
[eANDOWS2008TEST] C\SalesData

Also apply Rule to subfolders of the folders specified

Cancel l [ < Back “ Mext =

Examples

To synchronize only two subfolders named “FolderA” and “FolderB,” you would enter the
following:

\FolderA\ | \FolderB\

To synchronize all subdirectories except for subfolders “FolderA” and FolderB,” you would enter
the following:

\ | -\\FolderA\ | -\FolderB\
For our example scenario, the default “\” option will be used to process all subfolders.
To learn more about how to include and exclude subfolders, press the “F1” key on this panel.

Filtering Based on File Masks

The next panel displayed will let you indicate the files to be included or excluded from the job.
Each entry in this panel should be separated by a vertical bar (|) character. To exclude a file
name or file type, place a minus sign (-) in front of the mask.
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Rule Wizard for Sales Data =HAC X

File Masks

File masks that must be present for this rule to apply

.|

tmp |-~ .doc

Separate file masks with vertical bar characters (| ). File masks may
include standard wildeard characters and can be preceeded with a
hyphen ( - Jto exclude matching files from the rule. These file masks do
not affect the selection of folders. Press F1 for mare help.

Cancel | | <Back | Finish

Examples

To synchronize only *.doc files and a file named “Test.txt,” you would enter the following:

*.doc | Test.txt

To exclude *.tmp files, *.doc files, and a file named “Test.txt,” you would enter the following:
-*tmp | -*.doc | -Test.txt

The default setting for this panel is *.* | -*.tmp | -~*.doc | -~$.doc? | -~$.xIs?. This tells SureSync
to synchronize all files except *.tmp files and some commonly used Microsoft Office programs

temporary files. This is the setting we will use for this example.

To learn more about how to include and exclude files based on file masks, press the “F1” key on
this panel.

Clicking the “Finish” button will create your Relation. The Relation Wizard only displays a subset
of essential options for a Relation. There are many other options that can be configured by
modifying the properties of the Relation using the SureSync Desktop. Pressing the “F1” key on
any tab in the application will display context sensitive help detailing the options on that tab.

Previewing Your Relation

Once the Relation has been created SureSync will prompt you to preview the newly created
Relation. The preview displays the actions that SureSync would perform without actually
executing them. This is a great way to determine if your Relation will perform as expected. You
should always preview a Relation after making changes.

When prompted to preview, click on the "Yes" button.

There are different displays available for the preview by selecting options under the "View" menu.
Please consult the SureSync Help File for more information about the preview window.

You may browse through the folders in this window and see how your files are affected. A legend
can be accessed from the “Help” menu by selecting “Legend.” This will detail what the various
preview icons mean.
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When you are done with the preview, close the preview window. This will perform no action. You
can also click the “Run” button to run from the Preview.

SPIAgent Compression & Encryption

The SPIAgent Add-On also provides the ability to compress and encrypt data during the
transmission. This functionality is very useful when dealing with slow lines or public lines like the
Internet. For example, if you're synchronizing over the Internet, turning compression and
encryption on is recommended. This minimizes bandwidth consumption and secures the data
stream that is being transmitted.

If you want to enable compression and/or encryption, simply click on the Performance tab of the
Relation and check the “Use Compression” and “Encrypt Data” checkboxes.

l i Relation Sales Data

Execution and Network Priority | (Default) (=]

Use Compression
| Use CRC to validate open file copies
Use CRC to validate all file copies
Encrypt data
Allow use of Delta Processing on non-local drives

| Use database history for multi-way Rules

Creating a Real-Time Monitor

A Real-Time Monitor is used in place of a Schedule to constantly monitor changes in files. When
a change is detected, the associated Relation/Rule is applied, and the synchronization is
immediately performed.

The real-time feature requires the use of the optional SPIAgent component on each machine
involved in the real-time synchronization. A SPIAgent license is also required for the local
machine that will be running the job. (if that machine is involved in the synchronization)

In this example, we will create a Real-Time Monitor to process changes to our Relation as they
occur.

A Relation can only be running in one instance at a given time. If you
are planning to run a Relation with a Real-Time Monitor then you should
not attempt to run a Schedule of that same Relation at the same time.
You will get errors about the Relation already being busy. If a Schedule
exists to run a Relation you're going to run with a Real-Time Monitor, it
should be placed on hold or deleted.
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To begin configuring your Real-Time Monitor, go to the File menu, select “New,” and then
“Monitor.”

The wizards are designed to quickly and easily configure the basic
options needed to get a Real-Time Monitor up and running. SureSync is
an extremely flexible product with many advanced options. Additional
options can be specified on the properties panels for the Real-Time
Monitor after it has been created.

Name Your Monitor

ﬁ Monitor Wizard =RECIHL X

Monitor Name

You use a Monitor to package one or more Relations into a job. This job
remaing running, monitoring file and folder changes. Intervals can be used
to control when files are actually copied.

Specify a unigue name for your Monitor

Sales Datal

Describe this Monitor {optional)

The first panel allows you to name your Real-Time Monitor. Enter the name of the Real-Time
Monitor and an optional description. Then click “Next” to continue.

Selecting What Relation(s) to Run

The next panel is where you specify which Relation you would like this Real-Time Monitor to run.
Specify these Relations by checking the box next to their name. You can run multiple Relations

under one Real-Time Monitor.
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ﬁ Moniter Wizard ==

Relations used by Monitor

Relations with root paths being monitored

[] 2 Path Recovery
[] 3 Path Recovery
[ File Locking Test
Sales Data

[] Schedule Path Drop

| Cancel || <Back | Finish |

Click the “Finish” button to create the Real-Time Monitor.

Enabling SPIAgent File Locking

When the wizard is complete you will be returned to the SureSync desktop and the Real-Time
Monitor you created will be displayed. To enable SPIAgent File Locking, you must turn an option
on before starting your Real-Time Monitor. Click on the Real-Time Monitor, go to the “Options”
tab, and check the box for “Lock all open files.”

- Menitar Sales Data

:n—':_ Relat ntervals Options l Merts

Computer that should execute this | (an: Schedul
Manitar (Any ulen) Iz‘

If the specified server is unavailable, use any server running the
Scheduler service.

Lock all open files

[T Cancel active file copying when ending intervals

0| Number of times to restart a failed job (D=unlimited)

00:05 Time between retries (hours minutes)

Cancel Lpply

Click “Apply” to save the change. Now when the Real-Time Monitor is started, file locking will be
used.

Modifying and Running Your Real-Time Monitor

You can make changes to the options for your Real-Time Monitor in the main SureSync window
by first clicking on the Real-Time Monitor you wish to modify. You can then look through the tabs

Software Pursuits, Inc. 24
www.SoftwarePursuits.com




on the right side for options to change. Pressing “F1” while on any tab will bring up context
sensitive help describing the options in detail.

Now that the Real-Time Monitor is created and fully configured, it may be started by right-clicking
on the Real-Time Monitor name and clicking "Start Monitor," You may also uncheck the box that
says "Stop Monitor and place it on hold" on the General tab of the Real-Time Monitor. Then click
apply to start the Real-Time Monitor. Next to the Real-Time Monitor name will be the message
"Waiting to start,” which will change to "Active" automatically after a few moments.

Configuring E-mail Alerts

E-mail alerts can be a useful way of notifying the SureSync administrator of a problem which
should be investigated.

Confiquring a SMTP Profile

To start the configuration of alerts, you must launch the SPI1Agent Configuration utility and create
a SMTP profile. The SMTP profile provides SureSync with the necessary details about your
SMTP e-mail server so the program can send messages to you.

To launch the SPIAgent Configuration utility, open SureSync, go to the “Tools” menu and select
“Alert user list...”

(Sl | S

—_

1 SFI Alert Configuration

File Alert Users  SMTP Profiles Help
| SMTP Profies |
| E-Mail Address

User Name Mail Profile |

F

To create a SMTP Profile, go to the SMTP Profiles menu and select “Add New SMTP Profile...”

! Add SMTP Profile = | B |
Profile Name | STMP Server
SMTP Server | smtp.domain.com
SMTP Port 25
Sender Name | SureSync Admin
Sender Address | suresync@domain.com
Reply Address | suresync@domain.com
SMTP Server Authentication
User Name | username
Password | =
Confirm Password | =
Cancel | [ 0K
)
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The “Add SMTP Profile” panel allows you to define the SMTP settings for your mail server. The
following fields must be configured:

Profile Name: The name of the profile that you are configuring. For example, you might
use the name of the SMTP server.

SMTP Server: The server address of the SMTP server. For example, smtp.mail.com.
SMTP Port: The SMTP port for the SMTP server. The default SMTP port is 25.

Sender Name: The name that will appear in the From: field of messages sent by
SureSync.

Sender Address: The e-mail address that will appear on messages sent by SureSync.
Reply Address: The reply address that will appear on messages sent by SureSync.

You can also define SMTP Server Authentication settings if your SMTP server requires a valid
logon to send messages (most do). The following fields can optionally be configured:

User Name: The username that SureSync will log into this SMTP server with when
sending an e-mail alert.

Password: The password for the username defined in "User Name" should be entered
here.

Confirm Password: The password for the username defined in "User Name" should be
confirmed here.

Click “OK” to create the SMTP Profile. Clicking on the SMTP Profile tab of the SPIAlert
Configuration Utility will show the new profile.

! SPI Alert Configuration =HACH[ X

Profile Name | SMTP Server | Fort | Sender Name | Sender Address | Reply Address |

STMP Server smtpdomain.. 25 SureSync A...  suresynci@do... suresynciEd..

1 3

Confiquring an Alert User

The second part of configuring E-mail Alerts is to define an Alert User. The Alert User defines the
e-mail address(s) that will be sent messages when errors occur. To configure an Alert User, click
on the “Alert Users” menu and select “Add User...”
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I Add User to Alert = | O] |

User Name
Support Team
E-Mail Address
user@domain.com user 1 @domain.com user2@domain.cc
Mail Profile Name
STMF Server |

| cancet |[ oKk |

24

The “Add User to Alert” field has the following fields to be configured:

User Name: The username that will be used in SureSync to represent this e-mail
address.

E-mail Address: The e-mail address that SureSync will send the alert messages to.
e Mail Profile Name: The SMTP profile that will be used to send the message.

Multiple e-mail addresses can be added by separating the addresses
with commas (,) or semi-colons (;). This allows you to easily send
messages to a group of SureSync administrators.

Confiquring the Real-Time Monitor to Send Alerts

The final step of the alerts configuration is to tell the Real-Time Monitor to use the Alert User and
at what level of errors to send alerts. This is accomplished by clicking on the Real-Time Monitor in

the SureSync desktop, clicking on the Alerts tab, selecting the Alert User from the drop-down
menu and then clicking “Apply.”

. Menitor Sales Data

Alerts

Specify a userto receive an e-mail alett f a job encounters emors.

Userto Alett | Support Team E

Alert Level | 3-\Warnings, Job Failures, and Severe E‘

Alert Users...

Additional details about the E-mail Alert levels available can be found by pressing “F1” while on
the Alerts tab.
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Monitoring the Synchronization

Monitoring your synchronization job is important, and SureSync makes this process easy through

the use of two different status panels.

Detailed Status

The detailed status panel will show you file level activity for a current job as well as common

counters such as files added and files deleted. If you want to take an in-depth look at a particular

job, you will want to use Detailed Status.

To launch Detailed Status, right click on the job and select “Job Status.” You can also select the

job, go to the “View” menu and select “View Job Status.”

Actions

=

Server Name 9PGGCG1-JEFFK
Job Name BlendedStructure to NETTEST

Falder being examined \Gordon\QA Traces for issue 369143\Tovatest (remote)l

Waiting for tasks to complete.

170 Files Scanned 120 Added 0 Exceptions 101.2MB Copied
0 Journal Events 0 Replaced 0 Errors 79 % Transmission Savings
4 Active Actions 0 Removed
i 52 Actions Queued 0 Altered 00:00:23 Elapsed
File Name Action Bytes Copied % Complete Duration Lockouts Locking User Source Folder
SureSync2008.exe Copy 17.9MB of 543.2MB 3% 00:00:03 0 [local agent]ChSureSync 6 Py
Session-08082% 08-49.lo  Copy 413KB of 413KB 100% 00:00:00 0 [local agent]ChSureSync 6 Py
SyncFiles-080829 08-49.1 Copy 1.7MB of 1L.7MB 100% 00:00:00 0 [lacal agent]ChSureSyne 6 Py
Srv-DMSession-080829 ( Copy 892KB of B92KE 100% 00:00:00 0 [local agent]C:h\SuraSync 6 Pe
m | »
= Ea=—

Enterprise Status

The Enterprise Status panel can be used to view the current status of jobs from SureSync
installations anywhere on your network. To see detailed status, you can launch the Detailed
Status panel for a particular job right from the Enterprise Status application. The Enterprise
Status panel provides an easy way to stay current on the status of your jobs, no matter where

they are running.

Enterprise Status can be launched by going to the Start menu, selecting SureSync and then
“SureSync Enterprise Status”. You can also click on the “View” menu and select “Enterprise

Status,” or click on the “Enterprise Status” button in the menu bar.
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Actions
(@ (o e 55 (@ 7

Click on the bar below to display status in greups. Click on column names to sort and hold Ctrl to sort on additional calumns.

| MonitorHeld (4 items)

| MonitorRunning (5 items)

Scheduler 4| . + | Job Name Errors Exceptions Added Replaced Bytes Copied Deleted Altered Scanned
NASZ . Real-Time Archiving 1 o] 8 34 28.6Me 162 7 6,041
NASZ . Monitor Mirrors 0 o] o] 1 231KB 2 0 10,025
SPIWEBSVR . Mirror Archive to ArchiveBackupl (L) 0 o] 111 0 2.2GB 1,068 0 14,006
SPIWEBSVR . Mirror Archive to ArchiveBackup2 () 4] 4] 70 0 15GB 644 4] 14111
SPIWEBSVR . Real-Time Archiving 0 o o 0 OKB 0 0 0
ScheduleHeld (6 items)
ml e ik 2
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